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Welcome	to	Tech	25.	This	site	is	for	tech	fans,	novice	or	savvy	who	are	looking	for	quick	guides	on	how	to	do	stuff	with	your	latest	tech	gadgets	like	iPhones,	Smartphones	in	general	and	even	social	media.	We	hope	you	find	our	guides	helpful	and	entertaining	and	we	help	solve	your	issues	or	teach	you	something	new.	You	can	start	browsing	our
guides	based	on	categories	below.	Browse	by	Category	Learn	interesting	facts	about	the	Galaxy,	Science	and	tech	in	general.	From	black	holes	to	WiFi	to	even	facts	about	Cyber	Monday.	We	got	them	all.	Tips	and	tricks	about	social	media	platforms	like	Facebook,	Snapchat,	Instagram,	Tiktok	and	more.	Learn	to	be	a	social	media	pro	with	our	guides.
Learn	interesting	facts	about	your	favorite	tech	companies	or	entrepreneurs.	From	Elon	Musk	and	Twitter	to	Larry	Ellison	and	Oracle.	Discover	interesting	tips	about	your	favorite	tech	gadgets	or	services.	Need	to	know	how	to	create	a	table	from	an	Excel	sheet?	This	is	your	category	right	here.	The	Ultimate	Adobe	Illustrator	Tools	Guide:	Master
Every	Tool	in	Your	ArsenalAdobe	Illustrator	is	one	of	the	most	powerful	tools	in	the	design	world,	but	with	so	many	features	and	options,	it	can	be	overwhelming	for	both	beginners	and	even	seasoned	professionals.	Thats	why	mastering	the	Adobe	Illustrator	toolbar	is	crucial.	Whether	youre	a	new	designer	or	someone	looking	to	refresh	your	skills,
this	guide	is	the	perfect	resource	to	help	you	understand	and	use	every	tool	in	Illustrator	with	confidence.This	in-depth	guide	covers	everything	from	basic	shapes	to	advanced	features	like	gradients,	perspective,	and	the	blend	tool.	Lets	get	started	with	Part	1:	learning	the	basic	and	essential	tools!Part	1:	Fundamental	Tools	Every	Illustrator	Must
KnowWe	start	with	the	essential	tools,	the	backbone	of	every	design	project.	Understanding	how	these	work	will	give	you	the	foundation	to	build	more	complex	and	intricate	designs	as	you	progress.	Selection	ToolsSelection	Tool	(V)The	Selection	Tool	is	arguably	the	most	frequently	used	tool	in	Illustrator.	It	allows	you	to	select,	move,	and	modify
objects.	You	can	adjust	their	position,	size,	and	overall	structure	by	selecting	the	object	and	dragging	the	handles.(Insert	Image:	Basic	object	selection	and	manipulation)Direct	Selection	Tool	(A)The	Direct	Selection	Tool	allows	for	more	precise	edits	by	selecting	individual	anchor	points	or	paths	of	a	shape.	This	is	particularly	useful	when	you	need	to
manipulate	parts	of	a	path	or	fine-tune	certain	points	without	affecting	the	entire	shape.	Magic	Wand	Tool	(Y)The	Magic	Wand	Tool	is	excellent	for	selecting	similar	objects	based	on	fill	color,	stroke	color,	stroke	weight,	or	opacity.	It	saves	time	by	allowing	you	to	batch-edit	similar	objects	without	selecting	them	manually.Lasso	Tool	(Q)The	Lasso	Tool
lets	you	draw	a	freehand	selection	around	specific	anchor	points	or	parts	of	a	shape,	making	it	a	great	option	when	you	need	precision	and	control.Basic	Shape	and	Line	ToolsRectangle	Tool	(M)The	Rectangle	Tool	allows	you	to	create	perfect	rectangles	and	squares	(by	holding	down	the	Shift	key).	Its	one	of	the	most	commonly	used	shape	tools	and
can	serve	as	the	building	block	for	more	complex	designs.	Ellipse	Tool	(L)With	the	Ellipse	Tool,	you	can	create	circles	and	ellipses.	Hold	Shift	to	make	perfect	circles,	or	drag	freely	for	an	ellipse.Polygon,	Star,	and	Line	Segment	ToolsOther	useful	tools	in	this	category	include	the	Polygon	Tool	for	creating	polygons,	the	Star	Tool	for	stars,	and	the	Line
Segment	Tool	for	drawing	straight	lines	between	two	points.	Pen	Tool	(P)The	Pen	Tool	is	the	ultimate	vector	drawing	tool,	allowing	you	to	create	custom	shapes	by	drawing	straight	or	curved	lines	between	anchor	points.	Mastering	the	Pen	Tool	can	take	time	but	is	essential	for	creating	precise	paths	and	complex	shapes.Type	Tools	Type	Tool	(T)Use
the	Type	Tool	to	insert	text	into	your	design.	Its	perfect	for	creating	headlines,	body	text,	or	artistic	typography.	You	can	type	directly	on	the	artboard	or	inside	a	shape	to	make	the	text	follow	the	contours	of	that	shape.Area	Type	ToolThe	Area	Type	Tool	allows	you	to	fill	a	closed	shape	with	text,	which	can	be	useful	for	brochures,	posters,	or	when
designing	within	specific	boundaries.Transform	ToolsRotate	Tool	(R)Use	the	Rotate	Tool	to	spin	objects	around	a	fixed	point.	Holding	Shift	will	rotate	the	object	in	precise	45-degree	increments,	which	is	useful	for	creating	symmetrical	designs.Scale	Tool	(S)The	Scale	Tool	allows	you	to	resize	objects	proportionally	or	non-proportionally.	Holding	down
Shift	ensures	your	object	scales	proportionally.Shear	ToolThe	Shear	Tool	helps	you	skew	an	object	diagonally,	giving	it	a	slanted	appearance.Reflect	Tool	(O)With	the	Reflect	Tool,	you	can	flip	an	object	either	horizontally	or	vertically,	which	is	great	for	creating	mirrored	designs	or	duplicating	symmetrical	elements.Part	2:	Advanced	Tools	for
Specialized	DesignNow	that	youve	mastered	the	fundamentals,	lets	dive	into	the	more	advanced	tools.	These	tools	are	less	frequently	used	but	are	critical	for	advanced	design	work,	allowing	you	to	add	depth,	texture,	and	realism	to	your	illustrations.Width	Tool	(Shift	+	W)The	Width	Tool	is	a	fantastic	feature	for	adjusting	the	thickness	of	different
sections	of	a	stroke.	You	can	create	varied	line	widths	within	a	single	stroke,	adding	depth	and	dimension	without	needing	to	outline	the	stroke.Warp,	Twirl,	Pucker,	and	Bloat	ToolsThese	tools	are	part	of	the	Liquify	Tools	group	and	are	perfect	for	distorting	objects	or	adding	unique	effects.Warp	Tool	(Shift	+	R)	bends	and	warps	parts	of	your	design
with	smooth,	freehand	movements.Twirl	Tool	spins	parts	of	the	object,	adding	a	swirling,	tornado-like	effect.Pucker	Tool	creates	sharp,	inward	points,	while	the	Bloat	Tool	pushes	outwards,	giving	a	swollen	effect.Shape	Builder	Tool	(Shift	+	M)The	Shape	Builder	Tool	simplifies	creating	complex	shapes	by	allowing	you	to	combine	or	subtract	parts	of
overlapping	shapes.	You	can	drag	through	different	areas	of	your	selection	to	merge	or	cut	them	out,	perfect	for	logo	design	or	any	vector	work	involving	multiple	shapes.Blend	Tool	(W)The	Blend	Tool	is	great	for	creating	smooth	transitions	between	two	objects.	Whether	you	want	a	gradient	blend	of	color	or	a	morphing	of	shapes,	the	Blend	Tool
handles	it	all.Gradient	Tool	(G)The	Gradient	Tool	allows	you	to	create	color	transitions	between	two	or	more	colors,	either	in	linear	or	radial	form.	Mastering	gradients	can	elevate	your	designs	by	adding	depth	and	realistic	lighting	effects.Perspective	Grid	Tool	(Shift	+	P)The	Perspective	Grid	Tool	is	invaluable	for	drawing	objects	in	perspective.	It
provides	a	customizable	grid	that	allows	you	to	create	3D-like	effects	by	snapping	objects	to	vanishing	points.Mesh	Tool	(U)The	Mesh	Tool	offers	advanced	shading	and	color	transitions	by	dividing	an	object	into	a	grid.	You	can	adjust	each	mesh	point	individually	to	create	lifelike	gradients	and	complex	shadows.	Mastering	Adobe	Illustrator:	Final
ThoughtsAdobe	Illustrator	offers	a	vast	array	of	tools,	and	mastering	them	is	key	to	creating	high-quality	vector	designs.	While	some	tools	are	used	every	day,	others	like	the	Mesh	Tool	or	the	Perspective	Grid	Tool	may	be	used	only	in	special	situations,	but	knowing	how	to	use	them	can	be	a	game-changer	for	your	design	process.If	youre	looking	for
more	hands-on	learning	and	practical	demonstrations,	be	sure	to	check	out	my	YouTube	video	where	I	walk	you	through	some	of	these	tools	step	by	step!	This	video	will	help	you	see	these	tools	in	action	and	give	you	additional	tips	to	improve	your	design	workflow.Download	Adobe	Illustrator	+Photoshop	Lite	Free	LifeTimeAdobe	illustrator	Full
Course	Introduction	to	Adobe	Illustrator	ToolsAdobe	Illustrator	has	colossal	assortments	of	tools	fused	in	it,	and	when	Adobe	Illustrator	is	launched	then	we	go	over	certain	tools	which	we	use	to	apply	the	changes;	the	various	instruments	utilized	here	are	clarified	beneath	with	representations,	and	this	Adobe	Illustrator	Tool	is	about	the	selection	of
items	from	the	pictures	and	comprises	of	various	sub	tools	such	as	draw	tool,	a	type	tool,	paint	tool,	magic	tool,	modify	the	tool,	navigate	tool,	artboard	tool,	layers	panel	and	A	most	significant	aspect	regarding	this	is	we	can	utilize	shortcuts	to	initiate	these	tools.	One	of	the	most	important	things	about	this	is	that	we	can	use	shortcuts	to	activate
these	tools.	1.	Select	the	tool	artboard	tool	is	activated	by	pressing	Shift	+	Q;	in	this,	we	can	select	and	modify	there	within	the	selection.2.	DrawWhen	its	the	time	to	show	the	talent	and	draw	an	image	in	Illustrator,	then	all	needed	tools	are	bonded	together	in	this	tool.	From	the	Pen	tool	to	Pie	Graph,	we	can	take	startup	by	using	all	of	these	tools.
While	drawing,	we	need	some	of	the	easy	blended	tools	like	polygon,	start	tool,	ellipse	tool,	rounded	rectangle	tool,	and	rectangle.	We	just	have	to	click	on	this	tool,	and	we	can	make	use	of	these	ready-made	shapes.There	are	some	other	tools	for	making	and	editing	symbols	and	graphs;	we	dont	have	to	play	with	the	tools	used	above.	Here	we	can
place	a	symbol	and	edit	by	8	different	types	of	tools	just	for	the	symbol.	To	show	some	mathematical	values,	we	need	to	place	a	pie	chart	or	bar	graph,	then	we	get	the	readymade	tools	where	we	just	have	to	enter	the	values,	and	the	graph	is	ready.	We	can	modify	it	in	the	way	we	want	and	adjust	the	values	as	per.	.	Type	Tool	Adobe	Illustrator	Tool	is
used	to	enter	the	text	in	between	the	illustrations	wherever	we	want.	We	get	a	chance	to	write	anything	anywhere,	and	mainly,	we	can	write	in	any	position	we	want	as	we	have	a	vertical	type	tool,	Vertical	type	on	path	tool,	Type	on	path	tool,	and	Vertical	area	type	tool.	One	of	the	lovely	tools	is	the	Touch-type	tool;	by	using	this,	we	can	click	anywhere
on	the	screen	and	write	text	there;	also,	we	can	access	this	tool	by	pressing	Shift	+	T.4.	Paint	tool	Paint	tool	consists	of	the	Gradient	tool,	mesh	tool,	shape	builder	tool,	live	paint	bucket,	and	lives	paint	selection	tool.	The	gradient	tool	is	used	to	show	the	shades	of	color	and	can	make	a	new	one	by	mixing	two	or	more	colors.	Similarly,	to	help	this	tool,
it	has	a	live	paint	bucket	that	even	consists	of	combining	various	colors.	The	modification	is	a	key	part	of	the	software	as	it	has	to	make	changes	in	the	existing	without	affecting	the	original	object.	Here	in	this,	we	can	do	lots	of	changes	like	rotate,	making	the	mirror	of	the	original,	scaling	images,	reshaping	the	existing	shapes,	adjusting	the	width	&
height,	and	warping	it.The	tool	which	I	like	is	a	Twirl	tool;	as	in	this	tool,	as	long	as	we	hold	our	click,	the	more	twirl	well	come	to	see.	This	twirl	is	used	to	create	more	complex	shapes	by	repeating	them	again	and	again.	We	can	use	it	on	the	edges	of	the	circle	also;	we	can	change	the	options	by	double-clicking	on	the	tool.Even	there	is	a	Warp	tool
which	is	used	to	deflate	the	object	by	controlling	the	points.	Further	Pucker	tool	can	be	used	to	squash	everything	towards	the	center.	.	Navigate	ToolHere	we	go	with	the	navigation	tool,	which	we	can	say	plays	an	eternal	part,	as	it	is	used	every	minute.	If	we	make	some	changes	in	the	design,	then	we	need	to	zoom	in	and	zoom	out	the	illustration	to
see	how	changes	affect.	While	applying	the	effects	or	while	applying	the	colors,	we	need	a	hand	tool	for	panning	objects.	As	we	need	these	tools	continuously	in	command,	we	can	access	these	by	pressing	H	and	Z.	.	Artboard	ToolIt	is	the	tool	which	is	the	platform	for	the	printable	section	or	a	platform	for	an	object	to	be	exported.	Before	creating	the
artboard,	we	can	choose	different	preset	sizes	or	define	our	own	custom	artboard.	We	can	create	a	seamless	artboard	for	a	single	document	and	can	modify	its	size,	width,	and	length	and	can	place	it	anywhere	on	the	screen.	To	access	this	tool,	we	need	to	open	this	tool	and	directly	add	objects	by	dragging	and	dropping	them.	Each	artboard	is
bounded	by	a	thick	solid	line	and	shows	the	maximum	printable	area.	The	canvas	is	the	region	outside	the	artboard	that	can	be	extended	up	to	a	220-inch	square	window.	.	Layers	PanelUsually,	in	any	photo	editing	softwares	layers	are	the	common	tool	which	is	used	to	make	a	duplicate	copy	of	the	image	or	illustration.	By	using	this	tool,	we	can	keep
the	original	copy	unaffected	by	the	changes.	As	if	we	didnt	like	any	changes	made,	we	dont	have	to	do	undo	all	the	time;	we	can	directly	remove	the	layer	and	can	start	with	the	fresh	work.Another	use	of	the	layer	is	that	we	can	hide,	lock	and	can	save	the	appearance.	We	can	even	create	the	template	of	layers	that	we	can	use	to	track	the	artwork	and
exchange	layers	with	the	other	softwares	like	Photoshop.Usually,	in	layers,	Adobe	Illustrator	assigns	a	special	color	to	each	layer	as	it	can	be	done	up	to	9	different	colors.	The	same	color	has	been	reflected	in	the	window	of	the	box,	path,	anchor	points	and	center	of	the	object.We	can	see	in	the	below	image	how	the	different	layers	are	created	and
how	they	are	named.	We	can	see	the	four	columns	as	well	named	from	the	left	side	of	the	page	as	1.	Visibility	column	2.Edit	column	3.Target	column	4.Selection	column.	We	can	control	the	characteristics	by	clicking	on	them.	ArticlesThis	has	been	a	guide	to	know	What	is	Adobe	Illustrator	Tools.	Here	we	have	discussed	the	basic	concepts	and	the
characteristics.	You	may	also	look	at	the	following	articles:	Its	also	important	to	have	a	good	understanding	of	the	tools	and	features	available	in	Illustrator.	One	of	the	most	useful	tools	for	creating	complex	shapes	is	the	Shape	Maker	tool.	This	tool	allows	you	to	draw	basic	shapes	and	then	combine	them	to	create	more	complex	objects.	With	the
Shape	Maker	tool,	you	can	quickly	create	custom	shapes	and	designs	that	would	be	difficult	to	achieve	using	traditional	drawing	tools.Another	important	tool	in	Illustrator	is	the	Illustrator	Pen.	This	tool	allows	you	to	draw	precise,	scalable	vector	graphics.	With	the	Illustrator	Pen,	you	can	create	complex	shapes	and	lines	that	can	be	resized	without
losing	quality.	Whether	youre	creating	logos,	illustrations,	or	designs	for	print	or	web,	the	Illustrator	Pen	is	an	essential	tool	for	any	designer.If	youre	new	to	Adobe	Illustrator	or	looking	to	brush	up	on	your	skills,	Vivi	Designing	is	here	to	help	you	learn.	Photoshop	and	Illustrator	tutorials	can	be	a	great	way	to	learn	new	techniques	and	improve	your
workflow.For	those	looking	to	take	their	skills	to	the	next	level,	Vivi	Designing	offers	numerous	tips	and	techniques	to	help	you	take	control	of	your	design.In	addition	to	paid	courses,	we	offer	you	step-by-step	guides	on	some	of	the	important	techniques.Whether	youre	a	beginner	or	a	seasoned	professional,	theres	always	more	to	learn	in	Adobe
Illustrator.	With	the	right	computer	and	the	right	tools,	you	can	create	stunning	designs	and	illustrations	that	stand	out	from	the	crowd.	So	why	not	take	the	time	to	learn	Illustrator	online	for	free	and	start	creating	your	own	vector	art	today?	With	the	right	training	and	practice,	you	can	achieve	your	design	goals	and	create	the	kind	of	work	that	truly
inspires	you.In	this	article,	you	will	learn	aboutBasic	Tools	used	in	Adobe	Illustrator.	There	are	many	tools	in	Illustrator	that,	are	used	while	creating	artwork,	but	today	we	will	focus	on	the	use	of	basic	tools	that	a	beginner	must	know.	So,	lets	begin	with	the	tools	that	are	in	the	tool	panel.There	are	many	ways	tocurve	text	in	Adobe	Illustrator.	You	can
use	the	Arc	effect	from	Envelope	Distort,	or	you	can	use	theType	on	a	Path	toolIn	case	if	you	select	a	shape	accidentally,	no	need	to	worry.	Just	click	on	that	shape	again	and	it	will	be	deselected.In	the	above	image,	you	can	see	that	the	square	and	circle	shapes	are	selected	with	the	help	of	the	selection	tool.The	Direct	Selection	tool	helps	in	extending
the	edges	of	the	existing	shape	to	form	a	new	shape.	This	tool	is	placed	next	to	the	selection	tool	in	the	tool	panel.	The	shortcut	key	used	for	this	tool	is	A.Compare	the	above	image	with	the	selection	tool	image	and	you	with	notice	the	changes	in	the	shapes	which	have	been	done	with	the	help	of	the	Direct	Selection	tool.This	can	be	used	in	selecting
shapes	and	objects	with	simpler	attributes.	This	tool	helps	save	your	time.	Instead	of	selecting	similar	shapes	one	by	one,	you	can	easily	select	them	with	just	one	click.Click	on	the	magic	wand	tool	in	the	tool	panel	or	you	can	press	Y,	the	shortcut	key,	then	click	on	one	object	and	other	objects	with	similar	attributes	to	the	selected	object	will	also	get
selected,	and	then	you	can	edit	those	objects	at	the	same	time.In	the	above	image,	I	had	just	clicked	on	the	triangle	shape,	and	the	star	shape	was	automatically	selected	as	both	the	shapes	have	the	same	fill	color.This	is	another	version	of	the	Selection	tool.	This	tool	also	helps	in	the	selection	of	more	than	one	object	or	shape.	Click	on	the	Lasso	Tool
and	Drag	the	tool	on	the	shapes	you	want	to	select.	This	tool	is	just	another	option	for	the	selection	of	objects.	You	can	find	this	tool	next	to	the	magic	wand	tool	in	the	tool	panel.This	is	the	most	commonly	used	tool	in	the	illustrator.	In	the	beginning,	you	may	find	it	difficult	to	use	but	later	on,	you	will	enjoy	using	this	tool.The	Pen	Tool	is	used	to	draw
something	by	creating	paths.	Paths	are	lines	with	two	endpoints	called	anchors	and	anchors	have	two	handles	that	help	reshape	the	object.When	you	right-click	on	the	Pen	tool	in	the	tool	panel	you	will	see	other	tools:To	add	anchor	points	to	the	path,	select	the	path	and	then	click	on	the	pen	tool	then	move	the	pointer	to	the	path,	a	plus	sign	(+)	will
appear	next	to	the	pointer,	and	click	to	set	a	point	on	the	path.To	delete	any	existing	anchor	point	on	the	path,	follow	the	same	procedure	of	adding	an	anchor	point,	but	the	difference	here	is	that	a	minus	sign	will	appear	next	to	the	pointer	when	you	move	the	pointer	to	an	existing	anchor	point,	click	to	delete	the	anchor	point.You	can	find	this	tool	in
the	tool	panel	just	next	to	the	Pen	tool.	This	tool	helps	in	giving	a	smooth	curve	to	a	path.	With	the	help	of	the	Curvature	tool,	you	can	create	any	form	of	shape.In	the	above	image,	you	can	see	that	a	straight	line	has	been	converted	into	a	curve	with	the	help	of	this	tool.	To	reshape	a	path	with	the	help	of	this	tool,	select	the	path	and	click	on	the
curvature	tool.	Then	move	the	pointer	on	the	path	and	when	a	plus	sign	appears	on	the	pointer	click	to	add	a	point.	With	a	left	click,	you	can	drag	that	point	to	give	a	desired	shape	to	the	path.We	use	this	tool	to	add	text	to	your	artwork	or	image.	There	are	sub-tools	under	this	tool	which	you	can	see	by	right	click	on	the	type	tool	icon.	With	the	help	of
the	type	tool,	you	can	type	a	single	line	text	or	a	paragraph	text.To	type	Normal	Text,	Click	on	the	type	tool	and	then	click	on	the	artboard.For	Paragraph	Text,	Select	the	Type	tool	and	then	move	the	pointer	to	the	artboard	and	with	a	left-click,	drag	to	form	a	rectangle	or	square	shape.	You	can	adjust	the	shape	as	per	text	and	you	can	even	align	the
text.Area	Type	ToolType	on	a	Path	ToolVertical	Type	ToolVertical	Area	Type	ToolVertical	Type	on	a	Path	ToolTouch	Type	Tool	(Shift+T)By	not	making	it	more	confusing,	I	will	explain	the	use	of	these	above-mentioned	sub-tools	in	forthcoming	articles.It	helps	in	drawing	straight	lines	and	you	can	adjust	the	length,	angle,	color,	and	width	of	the	line
accordingly.The	name	clearly	states	what	this	tool	will	do	for	you	(obviously	it	will	draw	a	rectangle).	But	this	tool	has	other	shapes	too.	Just	right-click	on	the	rectangle	tool	and	you	will	find:Rounded	Rectangle	toolEllipse	Tool	(L)Polygon	ToolStar	ToolFlare	toolTo	pan	across	a	document,	you	have	to	click	on	the	Hand	Tool.	The	shortcut	key	for	using
the	hand	tool	is	H	but	you	can	also	press	the	space	bar	to	activate	the	hand	tool	and	pan	across	the	whole	document.If	you	want	to	obtain	the	desired	shape	by	adding	or	subtracting	two	or	more	shapes	then	Shape	Builder	is	the	tool	for	you.	With	this	tool,	you	can	either	add/combine	two	or	more	shapes	by	adding	their	paths	or	you	can	subtract	two	or
more	paths	to	form	another	shape.	You	will	get	a	clear	view	of	how	to	use	this	tool	by	understanding	the	below	image-In	the	above	image	to	get	the	desired	shape	2	overlapping	circles	are	drawn	with	the	help	of	the	Ellipse	tool.	Select	both	circles	with	the	help	of	the	Selection	Tool	and	click	on	the	Shape	Builder	Tool	in	the	tool	panel.Move	the	pointer
on	the	path	you	want	to	remove,	there	will	be	a	plus	sign	at	the	end	of	the	pointer,	click	&	hold	the	alt	key	and	a	minus	sign	will	appear	at	the	end	of	the	pointer.	Now	the	path	that	will	be	removed	will	get	highlighted	in	red	color,	click	to	remove	the	path.You	can	even	combine	two	or	more	shapes	with	the	help	of	the	Shape	Builder	Tool.	See	the	below
image-To	combine	both	circles,	first	select	them	with	the	help	of	the	selection	tool	and	then	click	on	the	Shape	Builder	Tool.	Move	the	pointer	on	the	circles	with	a	plus	sign	at	the	end	and	with	a	left	click,	drag	the	pointer	from	one	circle	to	another.	The	highlighted	path	is	the	preview	of	the	result	of	the	tool.	Click	to	combine	the	shapes.This	is	a	very
useful	tool	as	it	helps	in	giving	different	shades	to	your	artwork,	from	solid	to	light	fill.	You	will	enjoy	using	this	tool	as	it	is	easy	to	use	and	helps	give	a	new	effect	to	your	artwork	with	the	use	of	different	colors.	You	can	find	the	gradient	tool	in	the	tool	panel.When	you	double-click	on	the	gradient	tool	a	gradient	window	will	appear.	To	fill	your
artwork	with	gradient,	select	your	artwork	first	with	the	selection	tool.	Then	click	on	the	gradient	tool.	There	are	two	types	of	gradient	fill,	linear	and	radial.	Select	the	type	of	gradient	from	the	gradient	window.In	the	gradient	window,	you	will	see	a	gradient	slider	which	helps	in	adjusting	the	colors.	When	you	will	open	the	gradient	window	there	will
be	only	two	colors	on	the	gradient	slider,	white	and	black.	You	can	change	the	color	by	double-clicking	on	the	small	pointer	placed	below	the	slider.When	you	move	the	cursor	close	to	the	gradient	slider,	a	plus	sign	will	appear,	click	and	this	will	help	in	adding	a	new	pointer	to	the	slider.	You	can	see	in	the	above	image	that	I	have	added	color	pointers
and	even	I	have	changed	the	color	of	the	pointers.	After	selecting	the	artwork,	click	on	the	gradient	tool,	and	with	a	left	click	drag	your	cursor	over	the	artwork.	A	gradient	slider	will	appear	there.	You	can	rotate	the	slider	at	any	point	in	the	artwork	to	adjust	the	color.Practice	this	tool	and	you	will	end	up	playing	with	colors.The	Eyedropper	tool	helps
in	copying	color	from	any	object,	image,	or	artwork.If	you	are	wondering	how	I	have	got	this	raster	image	in	the	illustrator	then	keep	patience,	I	will	explain	this	in	my	forthcoming	articles.Now	get	back	to	the	eyedropper	tool.	With	the	help	of	this	tool,	I	have	copied	these	different	shades	from	the	image.To	copy	any	color,	select	the	object	or	shape	in
which	you	need	to	copy	the	color	then	click	on	the	eyedropper	tool	and	move	the	tool	over	the	color	to	be	copied,	and	then	click.	You	can	also	copy	color	from	and	object	to	another.With	the	help	of	the	eyedropper	tool,	you	can	fill	or	change	the	color	of	more	than	one	object	at	the	same	time.As	the	name	suggests,	this	tool	is	used	to	zoom	in	and	out	of
the	artboard.	You	will	find	this	tool	next	to	the	hand	tool	in	the	tool	panel.Ctrl	+	+:	This	will	help	you	to	Zoom	InCtrl	+	-:	This	will	help	you	to	Zoom	OutThe	tool	used	for	filling	color,	gradient,	or	pattern	in	the	artwork.	Fill	is	done	in	the	inner	area	of	the	object	but	it	is	not	compulsory.	It	can	be	applied	to	both	close-ended	and	open-ended	artwork.On
the	other	hand,	stroke	is	the	outer	line	of	the	artwork	or	object.You	can	easily	identify	from	the	name	itself	what	is	the	function	of	this	tool.	Yes,	this	tool	helps	in	erasing	but	erasing	what?This	tool	helps	in	erasing	the	path.	Right-click	on	the	erase	tool	on	the	tool	panel	and	you	will	find	two	more	tools;	Scissor	Tool	and	Knife.A	Scissor	Tool	is	used	for
cutting	the	path	and	a	knife	is	used	to	cut	an	object	or	shape	into	two	or	more	parts.From	the	above	image,	you	can	understand	the	use	of	the	Scissor	Tool.	To	cut	a	path	from	the	object,	select	the	object	with	the	Selection	tool,	and	then	right-click	on	the	erase	tool.Select	the	Scissor	Tool	move	the	scissor	towards	the	object	and	click	on	the	anchor
point	of	the	path	that	you	want	to	cut.The	blue	highlighted	line	will	show	you	the	path	that	will	get	cut.	If	that	is	the	path	that	is	required	to	be	cut	then	click	and	the	path	will	get	removed	from	the	object.Now	learn	the	use	of	knives.	Select	the	object	which	you	want	to	cut	into	different	parts.Right-click	on	Erase	Tool	and	select	a	knife.Move	the	knife
on	the	object	and	with	left	click-drag	the	knife	over	the	object	in	the	direction	in	which	you	want	to	cut	the	object.Then	click	on	the	selection	tool,	the	whole	object	will	get	selected,	deselect	the	object.Again	click	on	the	selection	tool	and	move	the	pointer	on	the	object	this	time	only	the	part	of	the	object	will	get	selected.Drag	the	selected	part	apart
from	the	other	part.	This	is	how	the	knife	tool	works.We	all	know	what	blending	means	and	the	same	meaning	applies	here.	Blend	Tools	help	in	blending	colors.In	this	image,	you	can	see	a	blend	options	window;	this	will	appear	when	you	double-click	on	the	blend	tool.In	the	above	image,	I	have	blended	two	different	shades	of	color.To	do	this,	draw	a
circle	with	the	ellipse	tool	and	make	a	duplicate	copy	of	it.	(Select	the	circle,	press	and	hold	the	alt	key,	and	at	the	same	time	with	left	click-drag	the	circle.This	will	duplicate	the	object.)	Fill	one	circle	with	a	color	and	another	circle	with	another	color.	(For	Strokes	click	on	No	Fill.	You	can	see	in	the	above	image	strokes	are	not	filled)	Now	select	both
the	circle	and	double-click	on	the	blend	tool.The	blend	option	window	will	appear.	Select	smooth	color	in	spacing	and	click	OK.	Move	the	pointer	on	the	first	circle,	a	plus	sign	will	appear,	then	click	to	blend	the	circles.There	are	a	lot	more	things	to	do	with	the	blend	tool	just	give	it	a	try.Artboard	is	the	place	where	you	draw	or	create	your	artwork.
You	can	find	this	tool	in	the	tool	panel.	This	tool	is	used	to	edit	the	artboard.With	the	help	of	this	tool,	you	can	change	the	appearance	of	the	artboard.	From	the	appearance	panel	also	you	can	edit	the	artboard.See	the	below	image	to	understand	more	about	the	Artboard	Tool.Now	you	have	learned	the	Basic	Tools	of	Adobe	Illustrator.	In	the	next
article,	you	will	learn	about	the	basic	panels	used	in	Adobe	Illustrator.The	fundamental	tool	in	Adobe	Illustrator	is	the	Selection	Tool	(shortcut:	V).	It	allows	you	to	select	and	manipulate	objects,	making	it	an	essential	tool	for	every	Illustrator	user.Adobe	Illustrator	offers	a	wide	range	of	tools	to	facilitate	diverse	design	tasks.	Some	notable	tools	include
the	Pen	Tool,	Type	Tool,	Shape	Tools,	Gradient	Tool,	Eyedropper	Tool,	and	Brush	Tool,	among	others.Determining	the	most	important	tool	can	vary	based	on	your	design	needs.	However,	the	Pen	Tool	is	often	considered	crucial	due	to	its	versatility	in	creating	precise	and	intricate	shapes.When	it	comes	to	illustration,	the	Pen	Tool	and	the	Brush	Tool
are	frequently	used.	The	Pen	Tool	is	great	for	creating	sharp,	vector-based	designs,	while	the	Brush	Tool	offers	a	more	organic,	hand-drawn	feel.Adobe	Illustrator	CC	(Creative	Cloud)	is	the	most	suitable	version	for	beginners.	It	offers	a	user-friendly	interface,	access	to	the	latest	features,	and	ample	learning	resources.Learning	Illustrator	can	be	made
easier	through	a	combination	of	online	tutorials,	courses,	and	practice.	Start	with	basic	tools	and	gradually	explore	advanced	features	to	build	a	strong	foundation.Adobe	Illustrator	may	seem	complex	initially,	but	with	consistent	practice	and	learning,	it	becomes	more	manageable.	The	key	is	to	start	with	the	basics	and	gradually	build	your	skills	over
time.To	begin	designing	in	Illustrator,	follow	these	steps:Familiarize	yourself	with	the	interface	and	basic	tools.Choose	a	project	or	concept	to	work	on.Sketch	your	ideas	on	paper	or	digitally.Use	the	Pen	Tool,	Shape	Tools,	and	other	tools	to	bring	your	sketches	to	life.Experiment	with	colors,	gradients,	and	effects	to	enhance	your	design.Creating	a
logo	in	Illustrator	involves	these	steps:Define	your	brands	identity	and	values.Sketch	out	several	logo	concepts.Open	Illustrator	and	create	a	new	document.Use	the	Pen	Tool	to	trace	or	refine	your	sketch.Incorporate	text	using	the	Type	Tool.Experiment	with	colors,	shapes,	and	effects	to	finalize	your	logo.100%(4)100%	found	this	document	useful	(4
votes)12K	viewsThis	document	provides	an	overview	of	every	tool	in	Adobe	Illustrator.	It	discusses	the	basic	functions	of	tools	like	the	selection	tool,	direct	selection	tool,	pen	tool,	type	tool,	shape	toAI-enhanced	title	and	descriptionSaveSave	The	Complete	Guide	to	Adobe	Illustrator	Tools	For	Later100%100%	found	this	document	useful,
undefined100%(4)100%	found	this	document	useful	(4	votes)12K	viewsThis	document	provides	an	overview	of	every	tool	in	Adobe	Illustrator.	It	discusses	the	basic	functions	of	tools	like	the	selection	tool,	direct	selection	tool,	pen	tool,	type	tool,	shape	toAI-enhanced	title	and	descriptionAdobe	Illustrator	can	be	pretty	daunting	for	beginners.	The
variety	of	tools	and	panels	as	amazing	as	they	are	need	some	time	getting	used	to.	But	where	do	you	start?	The	following	10	essential	tools	are	for	anyone	starting	out	with	Illustrator.But	first,	what	is	Adobe	Illustrator	and	why	should	I	use	it?Adobe	Illustrator	is	a	graphics	design	software	specially	for	vector	graphics.	Vectors	are	a	type	of	image	that
are	created	using	paths	rather	than	pixels.	This	means	they	are	quite	different	from	a	standard	JPEG	file	type.	A	benefit	of	using	a	vector	image	is	the	scalability.	Re-sizing	and	editing	can	be	done	easily	and	doesnt	leave	you	with	blurry,	pixelated	images.This	is	why	Adobe	Illustrator	is	preferred	for	logo	design,	illustrations	and	typography.	For
architecture	students	and	alike,	this	software	can	be	great	for	creating	effective	diagrams,	maps	and	even	simple	perspective	images.1.	The	pen	toolThe	pen	tool	is	a	versatile	feature	in	Illustrator	and	can	not	only	be	used	to	create	all	sorts	of	shapes	but	also	to	trace	hand-drawn	sketches	and	effectively	create	quick	and	editable	drawings.	By	using
the	Direct	Selection	Tool	(a.k.a.	the	white	mouse)	you	can	easily	edit	the	anchor	points	and	any	Bezier	curves.Here	are	some	examples	of	ways	to	use	the	pen	tool:Using	the	Pen	Tool	(P)	hold	down	Shift	to	create	straight	lines	at	0,	45	and	90	angles.creating	straight	linesUsing	the	Pen	Tool	(P)	click	to	start	a	point,	then	click,	hold	and	drag	to	create	a
curve.creating	a	bezier	curveIf	aligning	points,	make	sure	to	turn	on	Smart	Guides	by	going	to	View	>	Smart	Guides.using	smart	guides	to	alignTo	edit	shapes	after	they	are	closed,	use	the	Direct	Selection	Tool	(A)	and	click	on	one	point	to	isolate,	or	drag	over	more	and	move	to	the	desired	position.adjusting	anchor	points	2.	Type	tool	and	its	extra
bits	Many	people	use	the	type	tool	to	simply	add	text	to	an	illustration	or	drawing,	but	Illustrator	allows	you	to	do	much	more.	This	is	particularly	useful	for	typography	and	logo	designers	but	can	be	a	useful	tool	overall.By	holding	down	on	the	type	tool,	you	can	see	the	list	of	different	options	such	as	Type	on	a	Path	Tool	and	Vertical	Type	Tool.type
tool	and	its	extra	bitsCreating	text	around	a	shape	or	path	can	be	done	by	holding	down	the	Type	Tool	(T)	>	Type	on	a	Path	Tool.Then	make	sure	to	click	on	a	path	that	has	no	fill	or	stroke.	This	can	be	done	for	the	standard	shapes	or	by	making	one	of	your	own.	Its	also	not	limited	to	lines	and	curves.*Make	sure	to	click	exactly	where	you	want	the	text
to	start	on	the	path.creating	text	around	a	pathAnother	great	feature	is	to	convert	a	text	into	outlines.	Illustrator	allows	you	to	treat	a	letter	or	word	as	a	group	of	shapes	rather	than	text	which	can	then	be	modified.First	type	out	the	word	or	letters	in	the	desired	font	(dont	worry	about	the	size)	and	then	go	to	Type	>	Create	Outlines.	To	separate	each
letter,	you	can	select	everything	using	the	Selection	Tool	(V)	and	go	to	Object	>	Ungroup	(Shift	+	Ctrl	+	G)turning	text	into	shapesungrouping	shapes3.	The	Paintbrush	Tool	This	tool	is	quite	effective	for	those	with	a	graphics	tablet.	It	allows	your	strokes	to	be	vectorized	and	used	as	shapes	to	essentially	create	amazing	illustrations.	With	pressure
sensitivity	turned	on	you	can	create	a	varied	line	in	a	matter	of	seconds.	changing	the	pressure	sensitivity	of	a	brushusing	a	graphics	tablet4.	Layers	are	your	best	friend	The	layers	panel	is	probably	the	glue	that	holds	Adobe	Illustrator	together.	It	is	extremely	essential	when	creating	any	kind	of	graphic.	There	are	many	small	features	within	this
panel	that	are	important	to	unpack.	For	example,	let's	say	you	forget	to	create	your	layers,	but	want	to	separate	each	shape	or	object	on	to	its	own	layer.	Select	the	shape,	and	in	the	layers	panel	click	on	the	small	square	on	the	right-hand	side.	Then	drag	this	up	to	move	the	shape	on	to	its	own	layer	without	affecting	the	artwork.moving	shapes	to
their	own	layersYou	can	also	drag	and	drop	layers	to	move	shapes	in	front	or	behind	one	another.	It	is	a	good	habit	to	name	all	your	layers	so	that	they	are	easily	accessible.naming	layers	is	keyTo	lock	or	hide	layers	you	can	click	on	the	lock	shaped	icon	and	the	eye	icon	respectively.	This	can	be	useful	when	you	dont	want	to	mess-up	a	specific	layer
and	work	on	top	or	when	you	want	to	try	things	out	and	not	have	other	layers	interfering.	locking	or	hiding	layers	can	be	useful5.	Live	paint	Although	this	may	seem	like	one	of	the	more	complicated	tools	in	Adobe	Illustrator,	it	is	a	highly	useful	one	for	adding	colour	to	images	quickly.	Have	your	line	work	art	or	shape	ready.	Use	the	Selection	Tool	(V)
to	select	everything	you	want	to	colour	and	go	to	Object	>	Live	Paint	>	Make.	live	paintThen	use	the	Live	Paint	Bucket	Tool	(K)	which	is	hidden	under	the	Shape	Builder	Tool	and	choose	a	colour.	The	areas	highlighted	in	red	are	ones	you	can	colour	in.	If	you	try	to	colour	elsewhere	you	get	an	error	box.	live	paint	bucketAt	the	end,	make	sure	to
Expand	everything.	This	can	be	done	by	selecting	everything	using	the	Selection	Tool	(V)	and	clicking	on	the	expand	button	or	going	to	Object	>	Live	Paint	>	Expand.	If	you	missed	any	areas	that	cannot	be	used	with	the	Live	paint	tool,	you	can	always	select	and	Merge	by	going	to	Object	>	Live	Paint	>	Merge	and	go	back	and	paint	them.expand	-
alwaysYou	can	also	get	rid	of	the	strokes	to	get	a	clean,	line-less	finish.et	fin6.	Swatches	Swatches	are	useful	when	you	have	a	certain	colour	palette	you	want	to	stick	to.	Incredibly	useful	in	logo	designing	or	to	create	a	tone	within	your	artwork.	To	create	a	swatch,	you	can	go	to	Window	>	Swatches	and	create	a	new	swatch	with	the	colour	you	have
already	selected.	creating	a	swatchThis	can	also	be	sorted	into	groups.	Simply	create	a	new	group	by	clicking	on	the	upper	right-hand	side	options	and	choosing	New	Colour	Group.	creating	a	swatch	groupYou	can	name	your	swatches	for	a	project	and	edit	these	as	you	go.	You	can	also	download	or	create	swatches	you	find	online.	We	like	to	use
Adobe	Colour	(	to	look	at	new	colour	swatches	or	groups	of	swatches	that	you	can	easily	re-create	or	download	without	having	to	enter	the	Hex	code.	7.	Pathfinder	Tool	The	pathfinder	tool	is	a	simple	one	in	Adobe	Illustrator,	but	it	lets	you	play	around	with	different	shapes	and	basically	creates	either	cut-outs	or	merges	two	or	more	shapes	to	become
one.	You	can	find	the	pathfinder	panel	by	going	to	Window	>	Pathfinder.Next,	with	two	shapes	as	an	example,	we	can	use	the	different	options	to	create	completely	new	shapes:pathfinder	panelThe	first	is	to	merge	the	two	shapes.	You	can	do	this	by	placing	one	on	top	of	each	other	and	clicking	on	the	merge	tool.merging	two	shapesTo	cut	out	the
front-most	shape,	click	on	the	second	option	Minus	Front.pathfinder	minus	toolThis	tool	is	something	you	can	play	around	with	and	figure	out	which	options	best	suit	your	project.	8.	Image	Trace	Image	trace	is	a	good	illustrative	tool	for	artists	or	design	students.	It	can	turn	sketches	and	images	into	a	vectorised	format	making	it	easy	to	edit.	Here	we
show	you	two	examples	of	the	ways	in	which	image	trace	can	be	used.This	photo	of	a	man	can	be	turned	into	a	vector	with	a	few	easy	steps.	We've	used	an	image	from	Freepik	for	this	example.Hand	photo	created	by	luis_molinero.To	get	your	saved	or	scanned	photo	you	can	go	to	File	>	Place	to	add	the	image	in	Adobe	Illustrator.Re-scale	your	image
and	hold	down	the	Shift	key	to	make	sureyou	dont	lose	the	proportions.Next,	on	the	top	toolbar	you	can	see	the	option	to	Image	Trace.	When	you	click	on	this,	dont	be	alarmed	if	your	image	disappears	or	becomes	a	hideous	mess.	image	trace	panelClick	on	the	Image	Trace	Panel	to	display	more	options.	Our	photo	has	been	turned	into	a	silhouette
image	which	we	can	further	alter.	We	can	now	change	the	level	of	detail	and	magically	get	rid	of	the	white	background.Click	on	the	Advanced	arrow	and	make	sure	the	Ignore	White	box	is	checked.	check	this	magic	boxBut	what	if	you	wanted	to	keep	the	colours?	Or	make	the	image	not	so	detailed?To	do	this,	simply	choose	Colour	in	the	Mode	drop
down	list.	You	can	use	the	slider	below	to	change	the	number	of	colours	you	want	present.	Essentially,	the	smaller	number	of	colours	means	less	detail.	*This	is	extremely	helpful	when	creating	vector	people	to	use	for	architectural	illustrationscolour	image	traceHere	we	have	5	colours	selected	as	well	as	the	Ignore	Whitebox	checked.	However,	the
colours	are	seemingly	dull	and	too	similar.	Dont	fear,	we	can	change	this	too.Click	on	the	Expand	button	in	the	toolbar	or	go	to	Object	>	Live	Paint	>	Expand.	Next,	using	the	Direct	Selection	Tool	(A)	we	can	click	on	one	of	the	areas	that	we	want	to	change.selecting	the	same	colourBut	selecting	each	and	every	area	of	that	colour	can	be	difficult	and
long.	To	make	this	easier,	go	to	Select	>	Same	>	Fill	Colour.	Now	all	those	areas	are	selected	we	can	choose	a	new	colour	to	replace	this.	image	tracedWhat	if	you	wanted	to	Image	Trace	a	scanned	image	or	document?	Place	your	image	and	start	the	Image	Trace	process	like	before.	In	the	Preset	drop	down	menu,	you	can	choose	a	range	of	different
presets	with	different	setting	to	suit	the	outcome.	Here	we've	used	the	'sketched	art'	preset	to	get	a	simple	plan	outline.scanned	images	work	well	too9.	Patterns	Patterns	are	an	easy	tool	in	Adobe	Illustrator	and	making	your	own	pattern	allows	you	to	fill	larger	areas	with	the	same	shape	rather	than	copying	and	pasting	it	again	and	again.Here	we
have	a	hexagon	with	the	letter	'S'	cut	out	(Remember	creating	outlines	and	pathfinder	cut	out?)	which	we	want	to	make	into	a	pattern	to	fill	a	rectangular	shape.	Select	your	shape	with	the	Selection	Tool	(V)	and	go	to	Object	>	Pattern	>	Make.making	a	patternNow	we	can	adjust	the	size,	spacing	and	angle	of	the	pattern	you	want	to	create.	You	can
name	your	pattern	to	use	in	the	future	as	this	gets	saved	as	a	Swatch.	Use	the	Pattern	Tile	Tool	in	the	top	left	to	adjust	the	spacing	manually.adjusting	the	size	You	can	also	use	the	presets	to	change	the	style	of	the	pattern.	Were	going	to	select	Brick	by	Column.	brick	by	columnNow,	you	can	click	Done	to	save	this	as	a	pattern.	Basically,	we	can	use
the	pattern	as	we	would	any	fill	colour.	Since	it	has	been	added	to	swatches,	we	can	create	a	rectangle	and	select	the	swatch	to	fill	it	with	our	pattern.using	the	swatch	to	fill	a	shapepattern	made10.	Exporting	Youre	all	done	and	dusted	testing	out	these	handful	of	features	and	actually	managed	to	create	something	along	the	way.	But	what	now?
Saving	and	exporting	is	just	as	important	as	the	actual	outcome.	The	Save	As	feature	allows	you	to	save	your	document	as	an	Illustrator	file	(.Ai)	and	an	Adobe	PDF	whereas	the	Export'	feature	lets	you	save	in	a	large	number	of	formats,	the	most	common	being	.png	or	.jpeg.You	can	also	save	your	artboards	as	separate	images	or	pages	in	a	PDF.These
10	tools	and	features	are	just	the	tip	of	the	iceberg	when	it	comes	to	Illustrator	but	now	that	youve	covered	the	basics	we	hope	you	turned	from	a	newbie	to	someone	who	knows	some	of	the	ins	and	outs	of	this	particular	software	and	dont	worry	if	it	takes	a	while	or	if	along	the	way	you	make	some	happy	accidents	and	reveal	even	more	features.Which
other	tools,	tips	and	tricks	do	you	like	using	in	Adobe	Illustrator?	Share	copy	and	redistribute	the	material	in	any	medium	or	format	for	any	purpose,	even	commercially.	Adapt	remix,	transform,	and	build	upon	the	material	for	any	purpose,	even	commercially.	The	licensor	cannot	revoke	these	freedoms	as	long	as	you	follow	the	license	terms.
Attribution	You	must	give	appropriate	credit	,	provide	a	link	to	the	license,	and	indicate	if	changes	were	made	.	You	may	do	so	in	any	reasonable	manner,	but	not	in	any	way	that	suggests	the	licensor	endorses	you	or	your	use.	ShareAlike	If	you	remix,	transform,	or	build	upon	the	material,	you	must	distribute	your	contributions	under	the	same	license
as	the	original.	No	additional	restrictions	You	may	not	apply	legal	terms	or	technological	measures	that	legally	restrict	others	from	doing	anything	the	license	permits.	You	do	not	have	to	comply	with	the	license	for	elements	of	the	material	in	the	public	domain	or	where	your	use	is	permitted	by	an	applicable	exception	or	limitation	.	No	warranties	are
given.	The	license	may	not	give	you	all	of	the	permissions	necessary	for	your	intended	use.	For	example,	other	rights	such	as	publicity,	privacy,	or	moral	rights	may	limit	how	you	use	the	material.	Alright,	yall	today	begins	the	first	of	our	two-part	series	where	I	give	you	an	overview	of	EVERY	SINGLE	Adobe	Illustrator	tool.Whether	youre	a	total
newbie	to	Illustrator	or	youve	used	it	millions	of	times,	youll	find	this	guide	to	be	super	helpful!	Even	I	learned	of	a	few	new	tools	while	putting	this	post	together.The	thing	about	Adobe	Illustrator	is	that	there's	typically	more	than	one	way	to	accomplish	the	same	task.	Just	because	you	know	how	to	do	something	one	way,	doesnt	mean	its	the	easiest
or	most	straightforward	way	of	going	about	it.	With	that	being	said,	some	of	these	tools	offer	super	short	cuts	to	processes	you	may	already	have	a	system	for,	while	others	will	probably	yield	a	similar	amount	of	time	and	effort	to	accomplish	the	same	end	goal.	Either	way,	this	guide	is	a	quick	and	easy	overview	of	what	each	Adobe	Illustrator	tool	does
and	its	general	uses.	Also,	note	that	not	every	Adobe	Illustrator	tool	is	super	relevant	or	useful	(at	least	in	my	mind).So	understand	that	mastering	every	single	one	of	these	tools	is	totally	not	necessary.	There	are	several	Illustrator	tools	that	you	will	probably	never	touch	once	in	your	whole	graphic	designer	life.	So	if	at	any	point	while	youre	going
through	this	list,it	seems	like	an	Illustrator	tool	is	extremely	specific	and	realistically	something	youll	never	use	youre	probably	right.	But	just	in	case,	Ive	laid	them	all	out	for	you	anyway!Because	there	are	SO	many	Adobe	Illustrator	tools,	Ive	split	this	post	into	two	parts,	starting	with	the	top	half	of	the	Illustrator	toolbar,	ending	with	the	bottom.So
below	are	the	top	half	of	the	Adobe	Illustrator	tools	(which	you	can	find	in	the	toolbar	on	the	left-hand	side	of	your	workspace):	The	selection	tool	is	the	black	arrow	icon	that	you	use	all	the	time.	It	functions	as	a	typical	cursor,	allowing	you	to	select,click	and	drag	objects	and	text	around	your	screen.	The	direct	selection	tool	allows	you	to	individually
select	and	edit	specific	anchor	points	of	vector	shapes	or	lines.Where	the	regular	selection	tool	would	select	the	entire	shape,	the	Direct	Selection	Tool	enables	you	to	edit	one	angle,	side,	point	or	curve	at	a	time.-	Group	Selection	ToolThis	tool	allows	you	to	easily	select	a	specific	object	within	a	group	in	order	to	move,	edit,	or	resize	it	individually.I
actually	didnt	even	realize	this	was	a	real	tool	until	today,	but	Im	super	glad	it	exists	because	this	will	save	me	a	lot	of	time	and	eliminate	the	need	for	a	million	double	clicks	(which	accomplishes	the	same	thing	but	takes	a	lot	longer)!	This	tool	allows	you	to	click	on	a	single	object	in	order	to	automatically	select	everything	in	your	workspace	with	that
same	fill	color.This	would	come	in	handy	if	you	ever	needed	to	adjust	the	same	color	on	a	bajillion	different	shapes.	By	using	the	magic	wand	tool	you	only	have	to	click	once	to	do	so,	instead	of	clicking	on	every	object	individually!	The	lasso	tool	works	similarly	to	the	Direct	Selection	Tool	in	that	it	allows	you	to	select	individual	anchor	points	within	a
shape	or	object.	However,	the	Lasso	Tool	allows	you	to	draw	around	an	area	of	points	you	want	selected	so	that	youre	able	to	easily	select	several	at	a	time.	The	pen	tool	is	probably	the	most	important	tool	of	the	entire	program.	This	Illustrator	tool	allows	you	to	click	in	your	workspace	to	create	anchor	points.By	clicking	and	dragging	these	anchor
points,	you	can	maneuver	their	handles,	which	give	your	paths	curvature	and	shape.	By	connecting	several	anchor	points	with	this	tool,	you	can	create	unique,	hand	drawn	vector	shapes.This	tool	takes	some	practice,	but	once	you	have	it	down,	you	will	be	able	to	draw	freaking	awesome	vector	illustrations.	I	use	the	pen	tool	every	single	time	I	open
Illustrator,	so	if	there	is	any	tool	to	master,	its	definitely	this	one!-	Add	Anchor	Point	Tool	(+)The	add	actor	point	tool	allows	you	to	click	in	the	middle	of	an	existing	path	to	add	an	extra	anchor	point	to	your	shape	or	line.You	would	use	this	tool	if	you	needed	to	add	an	extra	curve	or	angle	to	your	shape,	without	having	to	fully	redraw	it.Once	youve
added	the	new	anchor	point	to	your	path,	use	the	direct	selection	tool	and/or	the	anchor	point	tool	to	manipulate	it	into	the	curve	or	angle	you	want	to	create.-	Delete	Anchor	Point	Tool	(-)The	delete	anchor	point	tool	deletes	anchor	points	from	paths	(pretty	self-explanatory,	I	know).-	Anchor	Point	ToolThis	tool	allows	you	to	add	or	maneuver	handles	of
existing	anchor	points	in	order	to	add	curvature	to	shapes	youve	already	created.	The	curvature	tool	is	another	great	way	to	create	vector	shapes,	especially	if	your	shape	has	mostly	curved	edges.It's	harder	to	have	perfect	control	over	your	curves	using	this	tool	than	is	with	the	pen	tool,	BUT	the	curves	of	this	tool	are	also	more	perfectly	round	than
the	curves	you	would	create	using	the	pen	tool.	I	suggest	using	this	tool	in	combination	with	the	pen	tool	to	create	the	perfect	shape	best	of	both	worlds!	This	tool	allows	you	to	add	text	to	your	Illustrator	document.To	use	this	tool,	either	click	on	your	artboard	and	begin	typing	which	allows	you	to	type	without	any	boundaries;	or	you	can	click	and
drag	to	create	a	text	box	and	THEN	begin	typing	which	will	restrict	your	text	to	stay	within	that	text	box.-	Area	Type	ToolThe	area	type	tool	allows	you	to	convert	an	existing	shape	into	a	text	box	and	type	within	it.-	Type	on	a	Path	ToolThis	tool	allows	you	to	use	an	existing	line	or	shape	as	a	path	to	type	on.-	Vertical	Type	ToolThe	vertical	type	tool
allows	you	to	type	your	text	vertically	instead	of	horizontally.-	Vertical	Area	Type	ToolThis	is	exactly	like	the	area	type	tool,	but	this	tool	allows	you	to	type	vertically	instead	of	horizontally.-	Vertical	Type	on	a	Path	ToolThis	tool	is	exactly	like	the	type	on	a	path	tool,	but	allows	you	to	type	vertically	instead	of	horizontally.-	Touch	Type	ToolThis	it	allows
you	to	select	individual	letters	of	existing	text	and	move	them	around.	This	tool	does	exactly	what	you	think	it	does	draws	lines!	Unlike	the	pen	tool	however,	you	cannot	make	connected	lines,	only	individual	ones.For	this	tool	and	the	ones	nested	under	it,	you	can	either	click	and	drag	to	create	your	lines,	or	you	can	click	one	single	time	on	the
artboard	and	specify	it's	dimensions	first.	If	you	hold	down	the	shift	key	you	can	create	a	line	at	a	0,	45,	or	90	degree	angles.-	Arch	ToolThis	tool	makes	arches	imagine	that!	However,	I	personally	dont	find	it	the	easiest	to	control	and	would	recommend	using	the	curvature	tool	instead	but	try	them	both	out	and	see	which	you	prefer!-	Spiral
ToolAnother	obvious	one	this	tool	makes	spirals!	This	is	actually	a	super	fun	tool,	however	I	dont	know	that	Ive	actually	ever	used	it	for	a	real	project	before.	But	if	you	can	find	a	practical	use	for	this	kudos!-	Rectangular	Grid	ToolThis	tool	is	actually	be	super	helpful	because	it	allows	you	to	create	create	tables	or	anything	else	youd	need	a	grid	with
rows	and	columns	for.Once	the	tool	is	selected,	you	can	click	one	time	on	your	artboard,	which	will	bring	up	a	window	where	you	can	specify	the	size	and	amount	of	rows	and	columns	you	want.	Hit	okay	and	your	grid	will	appear!-	Polar	Grid	ToolThis	tool	makes	a	polar	grid,	which	apparently	is	a	circular	target	looking	thing,	with	perpendicular	lines
that	meet	in	the	middle.	I	have	no	idea	what	you	would	ever	use	this	for,	but	its	there	if	you	need	it	I	guess?!	This	tool	makes	squares	and	rectangles.If	you	want	a	perfect	square	you	can	hold	down	the	shift	key	as	you	click	and	drag.Otherwise	just	click	and	drag	normally	to	make	a	rectangle.	If	you	need	your	shape	to	be	an	exact	size,	just	click	one
time	and	specify	the	size	you	want	your	shape	to	be	in	the	box	that	will	pop	up.-	Rounded	Rectangle	ToolThis	tool	works	exactly	the	same	as	the	rectangle	tool,	but	the	corners	are	rounded	instead	of	squared.If	you	want	to	adjust	the	roundness	of	the	corners,	use	the	direct	selection	tool	and	click	and	drag	on	the	little	circular	points	that	show	up	on
the	insides	part	of	the	corners	and	adjust	them	accordingly.-	Ellipse	Tool	(L)Fun	fact:	an	ellipse	is	a	circle.	So	any	time	you	want	a	circle	or	an	oval,	this	is	the	tool	youll	need.To	create	a	circle,	hold	down	the	shift	key.	If	you	want	an	oval,	just	click	and	drag.	Like	the	rectangle	tool(s),	if	you	want	a	specific	sized	circle,	just	click	once	on	the	artboard	and
adjust	your	settings	accordingly.-	Polygon	ToolThe	polygon	tool	makes	any	number	of	sided	shapes	from	triangles	to	hexagons	to	octagons	and	beyond.With	the	tool	selected,	all	you	need	to	do	is	click	once	on	your	artboard	and	define	how	many	sides	you	want	your	shape	to	have.-	Star	ToolThis	tool	obviously	makes	stars.	With	this	tool,	you	can
choose	how	many	points	you	want	your	star	to	have,	as	well	as	how	far	in	the	inner	points	go	towards	the	center.The	star	tool	is	super	fun	to	play	around	with,	given	how	many	different	variations	you	can	come	up	with.	Again,	just	click	in	your	workspace	with	the	tool	selected	to	define	the	number	of	points	you	want	your	star	to	have,	as	well	as	the
distance	you	want	between	them.-Flare	ToolThis	is	another	random	tool	that	I	have	never	actually	used	and	I	dont	totally	understand	who	does.	It	makes	this	weird	multi-circular	shape	with	some	weird	gradient	flares.Play	around	with	it	because	I	dont	even	really	know	how	to	describe	what	this	tool	does.	Youll	see	how	weird	it	is	for	yourself.	The
paint	brush	tool	makes	thicker,	paint-like	strokes	that	you	can	change	the	width,	shape	and	texture	of.This	tool	creates	brush	strokes	that	are	made	up	of	actual	lines,	so	after	youve	painted	them,	you	can	use	the	direct	select	tool	to	can	move	around	the	points	and	smooth	out	any	curves	that	arent	quite	perfect.	You	can	also	change	the	width	of	the
stroke	after	its	already	been	drawn	by	changing	the	line	weight.-	Blob	Brush	ToolThe	blob	brush	tool	is	the	same	as	the	paint	brush	tool,	but	instead	of	creating	lines	down	the	middle	of	your	brushstrokes,	it	creates	a	vector	shape	AROUND	the	brushstroke.	So	instead	of	creating	a	single	path,	it	creates	an	entire	an	area	instead.	The	shaper	tool	allows
you	to	draw	general	shapes	by	hand,	but	then	will	automatically	clean	them	up	and	create	the	shape	you	intended.	So	if	you	used	this	tool	to	draw	a	super	crappy	rectangle,	the	moment	you	release	your	finger	from	the	mouse	pad,	it	will	automatically	create	a	non-crappy	rectangle	for	you.-	Pencil	ToolThe	pencil	tool	is	similar	to	the	brush	tool	in	that
you	can	draw	lines	by	hand	without	using	the	pen	or	line	tools.	I	dont	use	it	often	because	it	can	be	difficult	to	handle	precisely,	but	occasionally	it	comes	in	handy!-	Smooth	ToolThis	tool	smooths	out	lines,	making	them	less	rigid	and	bumpy.By	clicking	and	dragging	the	smooth	tool	over	top	of	a	line	youve	drawn,	it	will	automatically	change	around	the
anchor	points	to	create	a	smoother	transition	between	them.	I	personally	dont	find	this	tool	to	work	super	well,	but	its	always	worth	a	shot!-	Path	Eraser	ToolWith	a	line	selected,	you	can	use	the	path	eraser	tool	to	draw	along	segments	of	the	line	you	want	to	be	erased.-	Join	ToolThe	join	tool	allows	you	to	take	two	paths	and	join	them	together	to
create	one	single	path.	With	the	join	tool	selected,	just	click	and	drag	a	circle	around	the	two	end	points	of	the	path	you	want	to	be	connected,	and	Illustrator	will	join	them	together	for	you.	The	eraser	tool	erases.	I	know,shocking,	right?	This	tool	really	does	come	in	handy	if	you	want	to	get	rid	of	a	section	of	a	vector	object	or	path.Unlike	the	path
eraser	tool,	this	tool	can	erase	entire	sections	of	shapes,	causing	your	vector	shape	to	redraw	its	outside	bounding	lines.-	Scissors	ToolThe	scissors	tool	can	be	used	to	cut	apart	a	vector	object	or	path.If	you	want	to	slice	apart	an	object,	use	the	scissors	tool	to	click	on	one	side	and	then	click	on	the	other.	Now	your	shape	is	cut	into	two	pieces	which
you	can	move	around	individually.	You	can	also	use	this	tool	on	a	path	by	clicking	once	on	the	section	of	the	path	you	want	to	be	separated.-	Knife	ToolThe	knife	tool	allows	you	to	do	the	same	thing	as	the	scissors	tool,	but	instead	of	only	cutting	straight	lines,	the	knife	tool	can	cut	in	any	jigsaw	manner	you	want!	Just	click	and	drag	the	knife	through
the	shape	and	voila!	The	rotate	tool	allows	you	to	rotate	shapes	in	a	circular	manner.To	use	it,	select	the	tool	and	click	once	in	the	middle	of	the	shape,	defining	your	axis	point	(that	blue	dot)	of	which	you	want	your	shape	to	rotate	around.	Then	click	and	drag	outside	of	the	shape	to	rotate	it	around!-	Reflect	Tool	(O)The	reflect	tool	works	similarly	to
the	rotate	tool,	but	instead	reflects	the	image	or	object	instead	of	just	rotating	it.Again,	you	need	to	select	an	axis	point,	then	click	and	drag	outside	of	the	shape	to	reflect	it.	This	tool	works	similarly	to	the	reflect	and	rotate	tools,	in	that	you	have	to	define	an	axis	point,	then	resize	by	clicking	and	dragging	outside	the	shape.	I	find	it	easier	to	forgo
using	this	tool	by	just	resizing	the	shape	as	normal	while	holding	down	option	and	shift	(which	resizes	it	proportionately	and	centered	to	where	the	object	already	resides)..	But	to	each	it's	own!-	Shear	ToolThe	shear	tool	angles	and	skews	your	objects	to	look	like	they	are	going	back	into	space.	This	tool	works	the	same	as	the	previous,	where	you
select	and	axis	point,	then	click	and	drag	outside	of	the	shape	to	shear	it.-	Reshape	ToolThe	reshape	tool	allows	you	to	select	multiple	anchor	points	on	a	line	or	shape,	and	move	them	all	in	the	same	direction.Its	essentially	the	same	as	the	direct	selection	tool	but	is	easier	in	maneuvering	several	points	at	the	same	time,	especially	if	you	want	them	all
to	move	in	the	same	direction.Whew!	Thats	a	lot	of	tools.	But	guess	what?	Thats	only	HALF!	Read	Part	Two	HERE!	

Illustrator	functions.	What	are	the	basic	tools	of	adobe	illustrator.	Adobe	illustrator	functions.


